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1 Turo XBT 

The Turo XBT system is an XBT (eXpendable BathyThermograph) data acquisition and 

recording system. The Devil, together with a standard Sippican (Lockheed Martin 

Sippican, Inc) launcher and XBT probes, makes up a complete XBT system. 

 

2 Scope 

This Manual covers the Devil XBT box, Turo supplied accessories and Devil Software 

(Turo XBT). 

This document refers to the Devil XBT. The full product range includes the following 

devices: 

Devil XBT 

Quoll XBT 

Quoll XBT-sv 

All functions, configurations, operating features and specifications of the Turo Devil 

XBT box are applicable to the Turo Quoll XBT and Turo Quoll XBT-sv boxes, and this 

document is to be used for the Quoll devices for USB, XBT operations. Additional 

features of the Quoll devices are described in other documentation. 

Because these devices operate with Sippican supplied equipment (probes, junction 

boxes, wiring and launchers) it is strongly recommended that relevant documentation 

for this equipment is read in conjunction with this manual. 
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3 Components 

Check that the contents match the items ordered. The following components may be 

included in this package: 

 Devil or Quoll Box 

 Ship’s Hull Cable 

 Devil Software (also called Turo XBT) CD 

 USB cable 

Equipment required to be supplied by the user includes: 

 Computer 

 Launcher (Hand Held or Thru Hull available from Sippican) 

 Optional GPS receiver, Garmin H16/17 or equivalent, with power supply  

 Junction Box (not essential) 

 Simulation Box or Test Canister (not essential) 

Computer requirements: 

 Windows 7 (32 bit or 64 bit) or Windows 8.1 

 200 MByte free disk space 

 512 MByte memory 

 USB Port 

 GPS, Iridium modem and Argos transmitter each require an RS232 Port (or 

USB to RS232 device). 

Optional equipment for specialised Ship Of Opportunity Program (SOOP) application: 

 Seimac Wildcat Argos transmitter with power supply for specialised SOOP 

applications (no longer supplied) 

 NAL 9601 Iridium modem with power supply for specialised SOOP 

application (if required) 

The Devil XBT System uses standard Sippican launchers and XBT probes. 
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Essential Devil Component 

 

Fig 1 Devil Box 

 

Optional Non-Essential Devil Components 

 

Fig 2 Non-Essential Optional Components 

Ship's Hull (Ground) Cable 

Devil Box 

Optional Turo or Sippican Junction 
Box 

Simulator Box 
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4 Hardware Installation 

4.1 Devil and Quoll Cabling and Interconnection 

The following diagrams explain the interconnections that need to be made. 

 

 

 

Fig 3 Cabling and Interconnection 

Ship’s hull should be connected 

to the Devil or Quoll Box 

OR 

to the Optional Junction Box 

DO NOT connect ship's hull 

to more than one  location 

If optional Junction Box is used, connect 

it to Devil or Quoll Box 

Cable to Launcher 

OR 

to Thru-Hull or Deck Launcher 

structure 

Connect USB cable to computer 

Connect signal cable to either the 

Launcher or the Optional Junction 

Box 
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System installation wiring: 

 

 

(with junction box) 

 

 

 

(without junction box) 

 

Fig 4 System Interconnection 
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4.2 Ship’s Hull, Ground, Shielding 

The performance of the system can be adversely affected by incorrect or non-ideal 

grounding and shielding. A secure permanent connection to the ship’s hull and proper 

connection of the screen and/or shield inside the cables is required. 

Very careful attention is required when making the ground/hull/seawater connection. It 

should only be at one point: 

 For a hand launcher this should be at the Junction Box or the Devil (or Quoll) 

Box. 

 For a hull mounted launcher it should ideally be at the launcher, if this is not 

possible then at the Junction Box or Devil or Quoll Box. 

It is IMPORTANT that there is only one connection to the hull. 

It is not necessary to have a Junction Box. With a DB9 connector, the launcher cable 

can be plugged directly into the Devil or Quoll Box. 

The following diagrams show recommended ground, hull and shield wiring. Although 

these are the recommended grounding, individual situations may require a different 

arrangement. 
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Fig 5 Devil or Quoll Ground and Hull Wiring with a Junction Box 
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Fig 6 Devil or Quoll Ground and Hull Wiring, NO Junction Box 
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4.3 GPS Option 

Most standard GPS receivers will work with the Devil. The requirement is that the 

output is RS232, 4800 baud and that the format is standard NMEA 0813 either 

$GPGGA or $GPGLL. 

Connect a GPS receiver output to any COM port. It is not necessary to specify the COM 

port because the Devil software will locate it. 

IMPORTANT 

The antenna and chassis of the GPS unit should not be connected to the ship’s 

hull. This is to reduce the possibility of ground loops introducing noise into the 

XBT acquisition. It is recommended that the power supply for the GPS be taken 

off an isolated mains (see section 4.2 Ship’s Hull, Ground, Shielding and Fig 4 

System Interconnection). 

4.4 Specialiased SOOP Application – Argos Transmitter Option 

The Devil supports Argos satellite communications. This is a legacy feature for an older 

transmitter that is no longer available. 

The only Argos transmitter that the Devil system supports is the WildCat Argos 

transmitter from Seimac (Nova Scotia, Canada). 

4.4.1 Argos Transmitter Connection 

This is a legacy feature for an older transmitter (Seimac Wildcat) that is no longer 

available. 

The Seimac Wildcat Argos transmitter requires an RS232 connection to the computer. 

This connection can be made either directly to an RS232 port (if available) or through a 

USB port using an RS232 to USB cable or adaptor. 

Use the optional “Seimac Wildcat Argos transmitter interface connector and cable” 

supplied with the Devil system to connect to the computer RS232. 

 

 

Fig 7 Argos Transmitter Components 

Connect power to Argos transmitter: 

Red = +12 Volts; 

Black = 0 Volts 

Connect 9 pin D connector to 
RS232 on computer 

Connect 15 pin D connector to 
Seimac Wildcat Argos Transmitter 
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IMPORTANT 

The antenna and chassis of the transmitter unit should not be connected to the 

ship’s hull. This is to reduce the possibility of ground loops introducing noise 

into the XBT acquisition. It is recommended that the power supply for the 

transmitter be taken of an isolated mains (see section 4.2 Ship’s Hull, Ground, 

Shielding and Fig 4 System Interconnection). 

Note that to set up the Seimac WildCat, the procedure using PTTcomm4 requires a 

serial RS232 to TTL converter, and NOT the “Seimac Wildcat Argos transmitter 

interface connector and cable” supplied with the Devil system. If an RS232 to TTL 

device was not supplied with the Wildcat transmitter, contact Seimac for details. 

4.4.2 Argos Transmitter and Windows Considerations 

The Windows computer Power Options set up needs to be configured for “Always On” 

so that when it is unattended for extended periods while transmitting, the computer will 

not disable the hard drive and will not go into Sleep or Hibernate mode. 

To do this, go to the Control Panel on the computer (Start->Control Panel) and double 

click on Power Options. Ensure that both “Turn off hard disks:” and “System standby:” 

are set to “Never”. This can be done by directly selecting the Settings or picking an 

appropriate “Power scheme” such as “Always On”. 

4.5 Specialiased SOOP Application – Iridium Transmitter Option 

Iridium satellite communications is supported. 

The only Iridium transmitters supported is the NAL 9601 and NAL 9602 modems. They 

implement Iridium Short Burst Data (SBD) communications. 

4.5.1 NAL9601, NAL9602 Transmitter Connection 

The transmitter requires an RS232 connection to the computer. This connection can be 

made either directly to an RS232 port (if available) or through a USB port using an 

RS232 to USB cable or adaptor. 

IMPORTANT 

The antenna and chassis of the modem should not be connected to the ship’s 

hull. This is to reduce the possibility of ground loops introducing noise into the 

XBT acquisition. It is recommended that the power supply for the Iridium 

transmitter be taken off an isolated mains (see section 4.2 Ship’s Hull, Ground, 

Shielding and Fig 4 System Interconnection). 

See Document “Devil Iridium Transmission” for complete details on how to make the 

RS232 connection and set up the transmitter. 
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5 Software Installation 

The system will run on Windows 7 (32 and 64bit) and Windows 8.1. Although there are 

differences between Windows 7 and Windows 8.1 in some of the dialog boxes, their 

Control Panels and configurations, those differences are minor. The following 

descriptions refer to Windows 7. 

5.1 IMPORTANT Windows 8.1 ISSUE 

Windows 8.1 has a important difference to Windows 7 when installing drivers. 

Unsigned drivers are handled differently. 

From time to time the drivers supplied by Turo may be unsigned and so with Windows 

8.1 specials procedures must be followed. These are described in the Driver section 

below. 

5.2 Devil Program (Turo XBT) 

Do not connect the Devil or Quoll Box into the computer yet. 

If a previous version of Devil is installed it is strongly recommended to uninstall it 

before installing another version. To uninstall go to 

Start-> Control Panel-> Programs and Features 

and select Turo XBT to remove completely. 

Insert the CD into the CD drive. The installation should commence automatically, if not, 

navigate to the CD directory and click on Setup.exe. Just follow the prompts. 

In the top directory of the CD, view the Readme file for further information. 

5.3 USB Driver 

The Devil or Quoll Box needs a driver to be installed. A special procedure is required 

for Windows 8.1. 

For Windows 8.1 follow the procedure in section “5.3.1 Setup for Windows 8.1 Driver” 

then proceed to section “5.3.2 Driver”. 

For Windows 7 go directly to section “5.3.2 Driver”. 

5.3.1 Setup for Windows 8.1 Driver 

After the software has been installed on the Window 8.1 computer carry out the 

following steps: 

Press CTR-ALT-DEL as if to shut down. Click once on the on/off icon in the 

bottom right of the screen to bring up the shut down options. While holding 

down the SHIFT key click “Restart”. 

The following screen will appear. Click Troubleshoot: 
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On the Troubleshoot screen click Advanced options: 

 

On the Advanced options screen click Startup Settings: 

 

On the Startup Settings Key press Restart: 
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When the next Startup Settings screen appears, press the F7 key 

 

The computer will now restart. When it starts up, unsigned drivers will not be 

blocked. 

Next, log on and proceed with “5.3.2 Driver Installation”. 

5.3.2 Driver Installation 

Connect the DEVIL or Quoll box to the computer using a USB cable. Windows will 

announce it has “Found New Hardware” and launch the “Found New Hardware 

Wizard”. 

If the Devil software has already been installed on the computer follow these steps: 

 “Welcome to the Found New Hardware Wizard” 

“Can Windows connect to Windows Update to search for 

software?” 

Check “No, not this time” 

Click Next 

 “What do you want the wizard to do?” 

Check “Install the software automatically (Recommended)” box. 

Click Next 



Devil XBT Manual  – 30 July 2015, Rev 15 Page 16 of 35 

 If you are asked “Please select the best match for your hardware 

from the list below”. 

Check: or DEVIL XBT 

  or QUOLL XBT-sv 

  whichever is appropriate to the hardware being plugged in. 

Click “Next”. 

 “The software you are installing for this hardware:” 
DEVIL XBT 

Click “Continue Anyway” 

 Click “Finish”. 

If the Turo XBT software has NOT been installed on the computer follow these steps: 

 “Welcome to the Found New Hardware Wizard” 

“Can Windows connect to Windows Update to search for 

software?” 

Check “No, not this time” 

Click “Next” 

 Check “Install from a list or specific location (Advanced)” 

box. 

 In “Locate Device Drivers” check the “specify a location” box. 

 Make sure the Turo XBT CD is loaded (if it starts to run the installation 

cancel it). Then browse to “\drivers” directory on the CD and click 

“open”, then “OK”, then “Next”, then “Finish”. 

 

5.4 Important Notes on USB 

The Devil or Quoll Box may be plugged into a USB port different from the one it was 

plugged into when the driver installation process was first carried out. In this case 

Windows XP may produce the message “New Hardware Found”. In that case the 

Wizard may appear, so do the following: 

 “Can Windows connect to Windows Update to search for 

software?” 

Check: “No, not this time”. Click “Next”. 

 “What do you want to do?” Check: “Install the software 

automatically (Recommended)”. 

Click “Next”. 

 If you are asked “Please select the best match for your hardware 

from the list below”. 

Check: or DEVIL XBT 

  or QUOLL XBT-sv 

  whichever is appropriate to the hardware being plugged in. 

Click “Next”. 

 If asked, click “Continue Anyway”. 

 Click “Finish”. 

USB devices are plug’n’play. Problems can occur when USB hubs are used and devices 
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are plugged repeatedly into different ports. This is a generic issue and is true for various 

types of devices - com ports, memory sticks, etc. There are ways of correcting problems 

that may arise, but it requires advanced knowledge of Windows devices, drivers and 

Windows registry. If the problem persists, contact the email address below in Section  

“Further Information”. 

5.5 Software Updates 

Check the Turo website for updates to the Turo XBT Program: 

http://www.turo.com.au/ 

 

*** NOTE the recommendation to uninstall previous versions before updating. 

 

http://www.turo.com.au/
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6 Operation 

When the software is installed and the driver is installed and the hardware is connected 

as described above in Section 4.1 “Devil and Quoll Cabling and Interconnection”, then 

dropping an XBT is straight forward. 

Users should check the Turo XBT website for documentation updates: 

(http://www.turo.com.au/). 

6.1 Running Devil for the First Time 

The MODE of Operation that the software will be set up for, is set when the program is 

run the "first time". Because this "first time" run is in effect a continuation of the 

installation, it's a bit messy to undo it if you later want to choose a different MODE. 

Doing an Uninstall of the program will not reset or change the MODE. See section 6.4 

Revert to Starting First Time. 

For this reason care is needed to consider the MODE of Operation before starting the 

program for the first time. 

6.2 MODE of Operation 

The Turo XBT system has many configuration options that are not necessary for many 

operations. The MODE of Operation is a feature that sets up the system for a type of 

operation. There are 4 Modes to choose from. All modes have Administrator and 

Operator types for users, with different levels of access to configuration parameters. 

Some, but not all, of the differences between the Modes are listed here: 

OPEN 

All options and configurations are accessible by both Administrators and Operators. 

Passwords are not necessary. Can be set up as a distributed computing system. 

RESTRICTED 

All options are accessible by Administrators. Only Ship and Voyage options are 

accessible by Operators. Password is necessary for Administrators. 

SOOP 

Most options are accessible by Administrators except servers for TSG and Depth. Only 

Ship and Voyage options are accessible by Operators. Password is necessary for 

Administrators. This Mode is designed to assist specialised Ship Of Opportunity 

Program (SOOP) operations. 

SECURE 

Most options are accessible by Administrators except for: only server available is XBT, 

no backup available, no option for a SOOP line, voyage name is preset. Only Ship 

Name option is accessible by Operators. Password is necessary for Administrators. 

This Mode is designed for some specialised navy operations, contact Turo for details. 

Further data file storage differences are described in section 6.8 

http://www.turo.com.au/
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Data Files. 

6.3 Starting First Time – MODE of Operation 

The user interface on the computer is used to operate the XBT system and can be started 

by double clicking on the Start Turo XBT icon on the desktop or going to: 

Start-> All Programs-> Turo XBT-> Start Turo XBT 

For first-time users it may be useful to gain an understanding of the operation by 

starting it in simulator mode. Simulator mode is accessed through the 

Start-> All Programs-> Turo XBT -> Utilities-> Start Simulator 

It functions in the same way as the real system with the exception that hand launcher 

operations are replaced with dialog buttons and XBT drops are simulated with actual 

data from the Pacific Ocean. The simulated drop latitude and longitude locations are set 

automatically but can be changed if the user wishes to demonstrate failure of the quality 

control checking. 

The first time the Devil program is started, the system will detect that no configuration 

has been previously set up and the user will be asked to select a Mode of operation in 

this window: 

 

These Modes represent styles of operation using a combination of Administrator and 

Operator access to different configurations and operations. Once a mode is selected, the 

user is guided through the initial configuration, with items highlighted in red that have 

to be filled in and the other items preconfigured to a default setting that may, but need 

not be changed. Unless the user is very familiar with the system, it is advisable to not 
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change the default settings. 

At the completion of this initial configuration process, the user is asked for an 

Administrator password. The initial predefined password is available on the distribution 

disk. 

The final part of the initial configuration involves setting up other users, with 

Administrator of User privileges. This can also be done at later times. 

Using the menu Help->About… it is possible to identify the Mode the system was 

configured for. 

6.3.1 Administrator 

When installing RESTRICTED, SOOP or SECURE modes the default administrator 

name and password is required. The name is “Administrator” and the password is listed 

in the accompanying Turo XBT CD in the file password.txt located in the directory 

\administrator. 

6.4 Revert to Starting First Time 

To determine which Mode was selected during the Starting First Time procedure, use 

the Help->About… menu.  

After the system has gone through the Started First Time procedure, it is possible to get 

back to a new Starting First Time. 

Exit the program, go to the directory: 

C:\Documents and Settings\All Users\Application Data\Turo\TuroXBT 

and remove all  ….xml files/ It is advisable to save these files in case it is necessary to 

get back to the exact Mode and configuration it was in before. 

Restart the Devil program and it will begin as a Starting First Time procedure. 

If the program is uninstalled and then reinstalled, the configuration will be maintained, 

so when the newly installed program is started for the first time it will not go through a 

Starting First Time procedure. 

6.5 Configuration 

Access to configurations varies depending on Administrator or Operator and which 

Mode was initially entered. 

The configuration can be saved as a default using the menu item Configuration->Save 

As Default. Administrators always have access to do this. 

Getting back to that configuration can be done at any time by either Administrators or 

Operators by using the menu item Configuration->Restore Default. 

6.5.1 XBT Device Selection 

Once the Devil is connected to the computer the appropriate XBT Recorder has to be 

selected in the Turo XBT software configuration menu. 

Change the operator to an Administrator and go to menu item: 

Configure->XBT & Interface… 
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use the XBT interface type selection to pick the desired device – Devil, Quoll Network 

or Quoll USB: 

 

 

 

If the XBT interface type selected is Quoll Network then a text box, labelled Suggest IP 

address, allows entry of an IP address: 

 

6.5.2 XBT Server Configuration 

The default setup for the configuration should be used. Go to Configuration in the menu 

and select: 

Configure->I/O & Servers… 

and ensure Auto start is checked. 

  

Fig 8 Server Configuration 

6.5.3 GPS Server Configuration 

To configure for GPS input, go to Configuration in the menu and select: 

Configure->I/O & Servers… 

 Ensure the “Use GPS server” and the “Auto start” boxes are ticked. 

 The “Host” should be “localhost” if the GPS receiver is connected to a COM 

port on the computer being used for the Devil software. 

 The port number should be 58297. 

 The “Source” should be “Serial GPS”. 

 Sever comms port button has no effect because the GPS is automatically located. 
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Fig 9 GPS Sever Configuration 

6.5.4 Satellite Transmission Configuration 

Satellite transmission is designed to support specialised SOOP operations. 

To use satellite transmission the transmitter server first has to be configured. Go to 

Configuration menu and select: 

Configure->I/O & Servers… 

 

Fig 10 Transmitter Server Configuration 

Then go to Configuration menu menu and select: 

Configure->Transmitter Message… 
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Fig 11 Transmitter Enable and Message Configuration 

Select the XBT Message required: 

 

Fig 12 Message Format Selection 

There are two formats of messages, BOM and CSIRO (see the document “Devil Data 

Formats” for a description of them). 

The message is constructed from the profile to a reduced number of points. The number 

of points is either preset (Fixed Length) or a variable length depending on the preset 

accuracy (Fixed Tolerance). The length or tolerance is settable in the Decimator area of 

the window. 

Note that for BOM Fixed Length, the length is not adjustable. 
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6.6 Carrying Out an XBT (or XSV) Drop 

To carry out a drop click on New probe Drop… button and follow the prompts. 

Only difference in carrying out and XBT or XSV drop is in selecting the probe type. 

This can be done either by using the drop down box Probe type in the Configuration 

menu (Configure->Probe and Interface…) or picking the probe type after clicking the 

New probe Drop… button. XSV probes are only supported by Quoll XBT-sv devices. 

6.7 Climatology, QC and Viewing the Data 

The climatology is an essential part of the Quality Control system. The climatology is 

used together with sophisticated processing to detect a number of quality issues such as 

wire break, bottom hit, wire stretch, noise, unacceptable inversion, outside the expected 

range (climatology) and so on. When a profile is plotted, data is flagged as good, 

suspect or bad with colour coding. 

Use the menu item Configuration and select: 

Configure->XBT & Interface… 

to enable the automatic break detection (Detect wire break): 
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Use the menu time Configuration and select 

Configure->Quality Control… 

to enable QC options: 

 

Data identified as bad or suspect is not removed or altered. Both the raw data and the 

processed/QC’d data, together with QC flags, are saved in the netCDF file (See 

document “Data Formats”). 
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6.8 Data Files 

The primary format for all data is netCDF. Data from every drop, whether a probe drop 

or a test drop, is stored in this binary format. 

Exported files are produced using the following steps: 

1. On completion of the drop, processing occurs by comparison with the 

climatology, checking for inversions, removing the first couple of meters and the 

last data points if isothermal. 

2. During initial processing, there is also a configurable option to apply a median 

filter to remove spikes. 

3. Only good data following this processing is then passed to the export formatters. 

4. For Sage (“.xbt”), the following extra processing occurs: 

A 5 point Hanning filter is applied to all remaining good data. 

5. This data is then passed through a fixed tolerance (0.05C) decimator.  This 

reduces the number of data points to the minimum number required to represent 

the profile to within a tolerance of 0.05C.  The resulting points are not evenly 

spaced in depth but selected as part of the decimation. 

6. This remaining dataset is what is used in the output file. 

The netCDF file contains both the raw and processed data (up to and including stage 2 

above).  The jjvv uses the decimated dataset derived from the XBT message type (in 

transmitter configuration) - typically this is based on the fixed tolerance decimator as 

per stage 5. 

See document “Data Formats” for a complete explanation of the data formats. 

6.8.1 Automatically Exported Files 

Depending on the Mode (see section 6.2 MODE of Operation) the system has been set 

up for, there are slight differences in the data files that are, by default, automatically 

stored and the files that can be exported. 

The operator can select and deselect the files that are automatically created at the end of 

each drop (or test). To set this up go to menu item: 

Configure->Files& Backup… 
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6.8.2 Manually Exported Files 

To manually export a file, use the menu item Files and select 

File->Export… 

then select the file or files to be exported from: 

 

 

Finally select the file types to be exported: 
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6.9 Test Canister 

The Turo XBT system takes into account the approximate wire resistances of the 

different types of probes. The test canister circuit may not have a known wire resistance 

that corresponds to a particular probe type. This may result in a very slight error in the 

reported test canister temperature, up to a few tens of milli-degrees. 

This error does NOT arise when doing a real probe drop because a probe is always 

selected. 

 

6.10 Simulator Box 

Using the optional Turo Simulator Box is similar to using a test canister, but without the 

need for a launcher. It has 3 calibrated temperature settings and is configured to look 

like a Deep Blue probe by having an appropriate “Deep Blue wire resistance”. 

Connect the Simulator Box as shown below. 

 

 

Fig 13 Simulator Box Connection 

The rotary switch selects the 3 different temperatures and the other 2 switches represent 

closing the breach (Load) and dropping the probe into the water (Launch). 

The Turo XBT System will only give correct results when the correct probe is selected 

in the Configuration (when using the Simulator Box select Deep Blue) 

 

Simulator Box 

Note that a Ship's Hull or 
Ground cable is not required 
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7 Advanced 

7.1 Servers 

The Devil software architecture follows a client server model. See document Error! 

Reference source not found.. 

There is a server for the Devil hardware, a server for the transmitter operation and a 

server for the GPS receiver. (There are servers for other operations as well, such as a 

thermosalinograph, but that is outside the scope of this system). 

The user interface includes all the configuration, operation and viewing windows that 

the operator uses is a client to each of the servers. 

Each of the servers and the client can be located on a different computer on a network. 

So it is possible to have the operator with the user interface located on one computer in 

an operations room, and the Devil hardware attached to different computer that is 

located more conveniently for carrying out the drop, the transmitter attached to yet 

another computer more conveniently located for wiring to its antenna and the GPS 

attached to computer located in yet another place. 

For installation in this distributed architecture please contact Turo. 

7.2 Debug Logging 

The Turo XBT software has the capability to log its internal operations. 

If a problem is encountered with the software, particularly if it is repeatable, logging the 

internal operations can assist with debugging. 

If a problem is being reported to Turo it may be useful to set up the logging to its 

maximum capacity. To do this it is necessary to be an Administrator. Then go to the 

menu item Options->Debug Logging Level and select All. The logging file can be 

located in: 

C:\Documents and Settings\All Users\Application Data\Turo\TuroXBT 

The filename is TuroXBT.log. 
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8 Specifications 

 

Turo XBT System 

Compatibility Fully compatible with Sippican hand 
 and thru hull launchers 

XBT Probes Sippican probes 
 T4 
 T5 
  T6 
 T7 
 T10  
 Deep Blue 
 Fast Deep 

XSV Probes Quoll XBT-sv device only 
 Sippican probes: 
 XSV01 
 XSV02 
  XSV03 

Electrical (see Fig 14 Test Circuit) 

Sample rate 10 Hz 

XBT Accuracy 0.002  °C equivalent typical 
 0.005  °C equivalent max 
 (using standard resistors to 
 simulate XBT probe) 

XBT Noise 0.001   rms °C equivalent typical 
 0.005   rms °C equivalent max 

XSV Accuracy/Resolution +/- 0.25 m/s / 0.04 m/s 
 (using reference signal to 
 simulate XSV probe) 

Computer connection USB 2.0, full speed 

XBT, XSV probe connection DB9 socket, Sippican compatible 

Power Supply USB bus powered plus 
 Quoll XBT devices only: 
 External 12V 
 Power over Ethernet (PoE) 
  

Mechanical (see Fig 15 Mechanical Schematic) 

Dimensions – box (L x W x H) 138.4 x 106.0 x 28.5 mm (Fig 15) 

Dimensions – non-skid foot height 5.0 mm 

Weight 275 gm 

Environment 

Ambient operating temperature -5 to +60°C 

Software Requirements 

Operating  system Windows 7 (32 & 64 bit) 
 or Windows 8.1 

Disk space used 200 MBytes 

Computer I/O USB, Ethernet (for Quoll) 
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Optional GPS 

GPS module Standard GPS unit (eg Garmin GPS17) 

Format NMEA 0813 ($GPGGA or $GPGLL) 
 4800 baud, 8 bit, no parity 

Computer I/O rs232 (or USB to rs232 module) 

Optional Argos Transmitter (Legacy support) 

Transmitter Seimac Wildcat Argos transmitter 

Interface Turo Argos Interface Module 

Computer I/O rs232 (or USB to rs232 module) 

Optional Iridium Transmitter 

Transmitter NAL 9601 or NAL 9601 

Interface Turo Iridium Interface Cable 

Computer I/O rs232 (or USB to rs232 module) 

 

 

 

 

Fig 14 Test Circuit 
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Fig 15 Mechanical Schematic 
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Further Information 

Further information is available from: 

 After the Devil software is installed, go to: 

  Start-> All Programs-> Turo-> Turo XBT-> Documentation 

 Check the Turo website site for updates to the Turo XBT Program and 

documentation: 

  http://www.turo.com.au/ 

 Further help may be available by emailing turo@turo.com.au. 

  

http://www.turo.com.au/
mailto:turo@turo.com.au
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Tasmanian Devil 

Sarcophilis harrisii 

 

 

 


